Лабораторная робота № 1.

Ознакомление с составом и использованием средств программирования и отладки микроконтроллеров семейства MicroCHIP.

Цель работы: 
Изучить состав средств программирования и отладки микроконтроллеров семейства MicroCHIP. Ознакомиться с порядком открытия нового проекта, ввода и редактирования программ в интегрированной среде разработки MPLab. Научиться компилировать и выполнять тестирование и отладку программ.  

Ход работы:

1. Изучить состав па​кета инструментов интегри​рованной среды разработки MPLAB (Integrated Development Environment -IDE MPLAB).
Включить краткое описание пакета в отчет. 

Все дальнейшие действия при выполнении лабораторной работы будут выполняться в среде MPLAB.
2. Установить режим разработки с использованием встроенного симулятора MPLAB-SIM Simulator. Для этого выберите в меню пункт Options>Development mode, который от​крывает окно настройки этого режима. Выберите опцию "MPLAB-SIM Simulator" в колонке слева и процессор PIC16F874 в ниспадающем меню справа. Затем нажмите кнопку "OK". Симулятор инициализируется, в нижней строке можно будет видеть надписи "PIC16F874" и "sim", про​грамма сейчас настроена для программной симуляции контроллера PIC16F874. 



Включить в отчет последовательность действий, необходимую для выполнения этого пункта.

3. Создание нового проекта. 


Симулятор, программатор и эмулятор могут работать с hex-файлами, которые созданы при помощи ассемблирования, компилирования и/или ком​поновки исходных кодов. Несколько различных программных инст​рументов могут создавать hex-файлы, и каждый такой инструмент может являться частью любого проекта. Надо сказать, что писать и ассемблировать программы можно и без создания проекта, но на​личие проекта позволит в дальнейшем гибко выбирать, какие инст​рументы будут использованы для создания hex-файла, один раз и на​всегда задать командную строку ассемблера и пути для всех использу​емых файлов. Поэтому лучше сразу обучаться работе с проектами. 


Перед созданием нового проекта рекомендуется создать новую папку, в которой будут храниться все файлы, создаваемые во время работы над проектом. Для этого лучше воспользоваться стандартными средствами проводника Windows. 


После того как создана папка будущего проекта выберите в меню программы MPLAB пункт Project>NewProject… В поле File Name введите имя нового проекта – файл с расширением .pjt. 



После нажатия кнопки “OK” открывается окно диалога Edit Project. В этом окне в строке Target Filename находится имя файла редактируемого проекта. Нажатием на кнопку “Change…” вы сможете еще раз задать параметры среды разработки MPLAB, используемые при компиляции проекта. В частности здесь можно выбрать тип контроллера (вкладка Tools), определить тип отладчика, выбрать режим использования Watch Dog таймера и др. В этом окне необходимо также определиться с временными параметрами, используемыми при отладке программы. Вкладка Clock позволяет выбрать режим тактового генератора : LP - низкочастотный резонатор; XT - обычный резонатор; HS - высокочастотный резонатор; RC - внешняя RC цепочка. Здесь же задается частота генератора. Остальные опции отладки можно оставить заданными по-умолчанию. 



В отчет о лабораторной работе необходимо включить полное описание всех установок интегрированной среды разработки MPLAB в режиме работы MPLAB SIM Simulator.



В списках файлов проекта будет находиться файл с расширением [.hex]. (область Project Files). Выбрав этот файл нажатием левой кнопки мышки, кнопка “Node Properties” станет активной. Нажав на кнопку “Node Properties”, появится диалоговое окно настройки параметров компиляции, в котором указываются правила создания шестнадцатеричного файла. Это диалоговое окно содержит параметры настройки, указанные по умолчанию для инструментального средства, показанного в правом верхнем углу. Диалоговое окно содержит несколько строк и столбцов. Каждая строка соответствует параметру, указываемому в командной строке при вызове инструментального средства. Установка параметров отображается в командной строке (Command Line), которая будет использоваться при вызове MPASM средой проектирования MPLAB IDE. По-умолчанию после компиляции генерируется файл ошибок и т.н. List File. 



После компиляции первой программы в отчет о лабораторной работе необходимо включить все файлы проекта. 



Закройте окно Node Properties и окно Edit Project.



Теперь необходимо создать новый файл, в котором собственно и будет содержаться текст программы на языке ассемблера и после этого подключить его к только-что созданному проекту. Выберите меню File>New. При этом будет создан новый файл с именем Untitled. Выбрав меню File>Save as… сохраните этот файл в папке проекта под именем  first с расширением  .asm. Зайдите в меню Project>Edit Project… и в окне Edit Project нажмите кнопку “Add Node…”. В открывшемся окне выберите файл first.asm и подключите его к проекту нажатием “OK”. Закройте окно Edit Project. 



Теперь можно приступать к написанию первой программы.

4. Ввод исходного текста программы.



Щелкните указателем мышки на чистом текстовом поле окна редак​тора и введите приведенный ниже текст. Комментарии, следующие после точки с запятой, вводить не надо. Текст надо вводить построчно.

;
File name:
   first.asm


list p=16f874

;определяем тип контроллера

#include <p16f874.inc>
;подключаем файл определения символических имен для данного ;процессора

c1
equ
0x20

;объявляем переменную с1 по адресу Ох20


org
0x00

;установить адрес начала программы - 0x00 - адрес вектора сброса


goto
start

;переход на начало основной программы


org
0x04

;начало размещения следующей части программы в памяти - обходим






;вектор прерываний

start




;метка начала основной программы 


movlw
0x09

;запись в рабочий регистр начального значения 0x09


movwf
c1

;копирование значения из рабочего регистра в переменную cl

loop




;метка начала цикла


decfsz
c1,f

;уменьшить значение с1, если результат 0 - пропустить следующую






;команду


goto
loop

;повтор цикла


goto
start

;если счетчик с1 обнулился, возврат на метку start –






;переинициализация счетчика 


end


;директива компилятору - конец программы



Это пример простейшей программы, которая циклически уменьшает ранее объявленную переменную cl и по ее обнулению воз​вращается на адрес начала инициализации счетчика. Первые две строки и последняя строка являются дирек​тивами ассемблера. Последняя строка означает конец программного кода. Первая строка указывает ассемблеру, для какого контроллера написан текст, вторая строка указывает на специальный файл p16F874.inc, в котором заранее, самой фирмой Microchip, описаны некоторые символьные имена именно для этого типа контроллера, которые могут применяться в программе. В частности, там указаны адреса регистров INTCON, OPTION_REG и других, поэтому при написании программы нет нужды указывать заново их адреса, а можно просто упоминать их имена. Файл находится в каталоге MPLAB. Вы можете открыть этот файл здесь же в среде MPLAB. Подробное описание директив компилятора смотрите в описании MPLAB IDE от MicroCHIP.



В отчете должна содержаться распечатка файла символьных имен и описание основных директив ассемблера.

 

Закончив ввод текста и проверив его правильность, сохраните файл.


В дальнейшем, для упрощения написания программ, можно вос​пользоваться готовым файлом-шаблоном. Файлы – шаблоны для различных типов процессоров находятся в директории ..\MPLAB\TEMPLATE\Code\. Этот тек​стовый файл уже содержит заголовок с местом для имени авторов, необходимые директивы и опции, стартовый фрагмент программы и даже фрагмент кода подпрограммы для сохранения и последующего восстановления значений аккумулятора W и регистра STATUS (у контроллера PIC16F874 нет команд PUSH и POP) при использовании обработчика прерываний. Вам остается только открыть этот файл в редакторе MPLAB, затем сохра​нить копию под нужным именем и ввести код своей программы. Не забудьте проверить и установить такие опции слова состояния кон​троллера, как тип тактового генератора, включение сторожевого таймера и т.д.! По умолчанию сторожевой таймер включен, и, если его использование у вас не предусмотрено, он будет каждые несколь​ко миллисекунд сбрасывать контроллер. Несоответствие слова состо​яния реальным потребностям вследствие рассеянности - очень рас​пространенная ошибка.
5. Компиляция программы.



Компиляция исходного файла может выполнена несколькими способами. Один из них - выбрать в меню Project>Build All. Если вы не создавали проект, а просто набрали в новом окне редактора исходный текст, то выберите пункт Project>Build Node. В любом случае произойдет фоновый запуск ассемблера, а перед этим исходный файл (проект) будет автоматически сохранен под именем, объявленным ранее. После окончания ассемблирования вы увидите окно результата. Если программа содержала ошибки, в окне будет выведен список сообщений об ошибках. Сделайте двойной щелчок мышкой на сообщении об ошиб​ке, и курсор автоматически перейдет на соответствующее место в исход​ном тексте. Разумеется, ассемблер выявляет только очевидные ошибки, такие как неправильный синтаксис, ссылки на необъявленные метки или переменные, неправильный тип данных. Выявлять логические ошибки, наподобие зацикливания, он не может.


Когда все ошибки устранены, ассемблер выдаст сообщение "Build completed successfully". Теперь мы имеем законченный проект, гото​вый к выполнению на симуляторе. 

6. Запуск программы.



В верхней части окна MPLAB, под строкой меню, отображаются кнопки, соответствующие командам меню. Крайняя левая кнопка переключает "четыре группы кнопок, применяемых для различных це​лей. Убедитесь, что отображается группа, в которую входят кнопки со стилизованными иконками светофора и человеческих следов. Сейчас нам понадобится именно эта группа. При наведении указателя мыши на кнопку в строке состояния отображается название запуска​емой этой кнопкой функции.


Инициализируйте систему нажатием кнопки "Reset" с изображени​ем символов перепада уровня и "#####". Программный счетчик бу​дет сброшен на ноль, что соответствует reset-вектору для PIC16F874. Строка исходного кода, соответствующая этому адресу, выделена темным фоном. В строке статуса MPLAB отображается состояние программного счетчика РС:0х00. По мере исполнения программы выделение смещается. Нажмите кнопку "Step" с изображением следов ноги. Будет выполнена первая команда (в нашем случае goto start). Программный счетчик будет показывать РС:0х04, темная строка пе​реместится на следующую исполняемую команду. Для пошагового выполнения можно также использовать функциональную клавишу <F7>. Понажимайте клавишу <F7> несколько раз и наблюдайте, как перемещается по тексту затемненная строка и изменяются показания программного счетчика. Нажмите клавишу "Run" с зеленым светофо​ром или функциональную клавишу <F9>, чтобы запустить програм​му в режим непрерывного исполнения. Цвет строки состояния изме​нится, показывая, что программа находится в режиме исполнения. До тех пор, пока программа не остановлена, никакие поля в строке со​стояния не могут быть изменены.


Остановите программу нажатием на кнопу с красным светофором или функциональную клавишу <F5>. Цвет строки состояния вернется к исходному и будет отображено текущее значение программного счетчика и другие параметры состояния.

7. Открытие других окон отладки


Используя программу MPLAB можно контролировать различные параметры исполнения программы. Например, наша программа должна периодически уменьшать переменную счетчика, но как это увидеть, чтобы убедиться, что программа работает правиль​но? Одним из способов является использование окна, отображающего значения, хранимые в регистрах общего применения. В нашей про​грамме для хранения значения переменной c1 используется ячейка памяти по адресу 0х0С из области регистров общего применения. Нажмите кнопку с надписью "RAM". Интересующее нас значение находится на пересечении строки 0000 и столбца ОС. Когда содержимое одной из ячеек изменяется, оно выделяется красным светом, что облегчает контроль над работой программы. Но если вы отлаживаете сложную программу, использу​ющую большое число часто изменяемых переменных, становится трудно определить, какая переменная изменилась в данный момент времени, поскольку красным цветом выделены несколько значений. Для решения этой проблемы существует так называемое смотровое окно (watch window).
7.1. Создание смотрового окна


Нажмите кнопку "Create New Watch Window" с изображением очков, либо выберите пункт меню Window>New Watch Window. В ди​алоговом окне введите имя переменной cl в поле "Simbol", или выбе​рите его в прокручиваемом списке. Нажмите "Add", затем "Close". Вы создали смотровое окно, которое выборочно отображает значение только переменной cl. Можно создать смотровое окно, которое од​новременно отображает значения нескольких переменных или регис​тров. В этом случае надо нажимать "Add" для каждого нужного значения из списка, а закончив формировать список нажать "Close". Нажмите несколько раз клавишу <F7> чтобы проверить, как изменя​ется значение переменной cl.
7.1. Сохранение смотрового окна



Для сохранения всех настроек текущего смотрового окна нажмите кнопку в его левом верхнем углу и выберите строку "Save Watch". Введите любое корректное имя и нажмите “ОК”. Настройки будут со​хранены в текущем рабочем каталоге, где расположен весь проект. При сохранении проекта также сохраняется вся информация об от​крытых и закрытых окнах, их размерах и расположении на рабочем столе. При последующем открытии проекта автоматически восста​навливается исходное состояние всех окон.


Ранее созданное смотровое окно впоследствии можно отредакти​ровать. Нажав на кнопку в левом верхнем углу, выберите "Edit Watch" чтобы удалить из окна ненужные значения, или "Add Watch" чтобы добавить новые значения. Кроме этого, для каждого из отоб​ражаемых значений, нажав кнопку "Properties", можно выбрать, как оно будет отображаться: в битовом, шестнадцатеричном или ASCII формате и т.д.
8. Задание точек останова.


Если программа находилась в процессе симуляции, нажмите <F5>, чтобы остановить ее. Щелкните мышкой непосредственно перед мет​кой "start" нашей учебной программы. Нажмите правую кнопку мыши и в появившемся меню выберите опцию "Break Point(s)". Строка, в которой расположен курсор, изменит свой цвет, сигнализируя, что сразу после исполнения команды в этой строке выполнение програм​мы остановится.


Сбросьте систему в исходное состояние клавишей <F6>, затем за​пустите на исполнение клавишей <F9>. При достижении точки оста​нова симулятор остановится на строке, следующей за точкой остано​ва (но эта команда не выполнится). Если нажать клавишу <F9> еще раз, симуляция программы продолжится как обычно, вновь изменит​ся цвет строки состояния, но наша программа работает в цикле, по​этому, после достижения точки останова, симулятор вновь остано​вится. Разумеется, когда программа работает в цикле, и не достигла точки останова, ее можно остановить нажатием клавиши <F5>. Ког​да программа остановлена, в смотровом окне и окне регистров обще​го применения отображаются текущие значения регистров.


Дополнительные рекомендации



Вы можете задать равнозначные точки останова в таких окнах, как:


Window>Program Memory.


Window>Absolute Listing.


Окно исходного текста (как было описано выше).


Если работаете с проектом, используйте окно Window>Project для быстрого вызова файлов, входящих в проект. Двойной щелчок на имени файла, выделенного цветом, открывает его в окне редактиро​вания.


Биты конфигурации, заданные в исходном тексте программы, (такие, как тип резонатора, включение/выключение сторожевого тай​мера и т.д.) не устанавливают автоматически соответствующие опции процессора для симулятора или эмулятора. Например, если в тексте программы вы установили опцию "WDT_OFF" - сторожевой таймер выключен, то соответствующий бит будет сброшен при записи про​граммы в кристалл при помощи любого программатора. Для от​ключения этого же режима в симуляторе или эмуляторе MPLAB не​обходимо с помощью меню Options>Processor Setup>Hardware от​ключить соответствующий режим. Такое отсутствие прямой связи между опциями в программе и режимом симулятора позволяет в про​цессе отладки изменять параметры, не меняя исходный текст.


Используя меню Options и Options>Environment Setup, вы можете:
· модифицировать панель инструментов

· установить расположение панели инструментов

· изменить количество знаков для меток и имен регистров

· настроить экранные шрифты

- перенастроить "горячие клавиши" для функциональных клавиш и специальных символов ASCII.
Лабораторная работа №2.

Исследование архитектуры микроконтроллера PIC16F874, 

организации хранения и обмена информацией. 

Цели работы: 

1. Изучить архитектуру микроконтроллеров среднего семейства MicroCHIP.

2. Ознакомиться с организацией памяти микроконтроллера. 

3. Ознакомиться с системой команд. 

4. Изучить команды обмена. Составить программу обмена согласно задания.

Выполнение работы:

1. Основные характеристики, архитектура и электрические параметры микроконтроллера PIC 16F874.

В настоящее время, устройства работающие в режиме реального времени часто содержат микроконтроллер как основной элемент схемы. PIC16F87X имеют много усовершенствований повышающие надежность системы, снижающие стоимость устройства и число внешних компонентов. Микроконтроллеры PIC16F87X имеют режимы энергосбережения и возможность защиты кода программы.

Основные достоинства:

• Выбор тактового генератора

• Сброс:

- сброс по включению питания (POR);

- таймер включения питания (PWRT);

- таймер запуска генератора (OSC);

- сброс по снижению напряжения питания (BOR).

• Прерывания (до 14 источников)

• Сторожевой таймер (WDT)

• Режим энергосбережения (SLEEP)

• Защита кода программы

• Область памяти для идентификатора

• Внутрисхемное программирование по последовательному порту (ICSP)

• Режим низковольтного последовательного программирования

• Режим внутрисхемной отладки (ICD)

Микроконтроллеры серии PIC (Peripheral Interface Controller) построены по Гарвардской архитектуре с использованием раздельных областей памяти и раздельных шин для данных и для команд. Это позволяет за один цикл получать одновременно доступ как к памяти команд, так и к памяти данных, что значительно уменьшает время выполнения программ. Кроме того, существует двухступенчатый конвейер, обеспечивающий одновременное исполнение текущей команды и выборку следующей.

Микроконтроллер PIC 16F874 имеет расположение выводов, показаное на рис.1.

[image: image1.wmf]Рис 1. Расположение выводов

микросхемы 

PIC 16F874.



Студенту предлагается включить в отчет о выполнении лабораторной работы следующие пункты:

· характеристики микроконтроллеров PIC 16F874;

· архитектура и назаначение выводов;

· электрические параметры микроконтроллеров PIC 16F874;

Соответствующая информация находится в документе “PIC16F87X Data Sheet 28/40-Pin 8-Bit CMOS FLASH Microcontrollers PICmicro™ “ на сайте производителя www.microchip.com. Дополнительную информацию можно почерпнуть из документа “Mid-Range Reference Manual”, который содержит подробное описание устройства и принципов работы микроконтроллеров среднего семейства фирмы MicroChip.

2. Организации памяти программ и памяти данных.

В микроконтроллерах PIC16F87X имеется три вида памяти. Память программ и память данных имеют раздельные шины данных и адреса, что позволяет выполнять параллельный доступ. Микроконтроллеры PIC16F87X имеют 13-разрядный счетчик команд PC, способный адресовать 8К х 14 слов памяти программ. Физически реализовано FLASH памяти программ 4К х 14 в PIC16F873/874. Обращение к физически не реализованной памяти программ приведет к адресации реализованной памяти.

Адрес вектора сброса – 0000h. Адрес вектора прерываний – 0004h.

Структуру памяти программ смотрите на рис.2. 

[image: image2.wmf]Рис. 2. Структура памяти программ

для 

PIC 16F874.


Память данных разделена на четыре банка, которые содержат регистры общего и специального (SFR – Special Function Registers) назначения. Биты RP1 (STATUS<6>) и RP0 (STATUS<5>) предназначены для управления банками данных.

В таблице показано состояние управляющих битов при обращении к банкам памяти данных.

	RP1: RP0
	Банк

	00
	0

	01
	1

	10
	2

	11
	3


Объем банков памяти данных до 128 байт (7Fh). В начале банка размещаются регистры специального назначения, затем регистры общего назначения выполненные как статическое ОЗУ. Все реализованные банки содержат регистры специального назначения. Некоторые, часто используемые регистры специального назначения могут отображаться сразу в нескольких банках памяти.

С помощью регистров специального назначения выполняется управление функциями ядра и периферийными модулями микроконтроллера. Регистры специального назначения реализованы как статическое ОЗУ.

В области регистров общего назначения программист объявляет свои переменные.

Обратиться к регистрам общего назначения можно прямой или косвенной адресацией, через регистр FSR.

Карта памяти данных изображена на рис. 3. 

[image: image3.wmf]Рис. 3. Память программ микроконтроллера 

PIC 16F874.


3. Система команд микроконтроллера PIC 16F874.

Каждая команда микроконтроллеров PIC16F87X состоит из одного 14-разрядного слова, разделенного на код операции (OPCODE), определяющий тип команды и один или несколько операндов, определяющие операцию команды.

Система команд аккумуляторного типа, ортогональна и разделена на три основных группы:

• Байт ориентированные команды;

• Бит ориентированные команды;

• Команды управления и операций с константами.

Полный список команд смотрите в таблице 2. Описание полей кода операций смотрите в таблице 1.

Для байт ориентированных команд 'f' является указателем регистра, а 'd' указателем адресата результата. Указатель регистра определяет, какой регистр должен использоваться в команде. Указатель адресата определяет, где будет сохранен результат. Если 'd'=0, результат сохраняется в регистре W. Если 'd'=1, результат сохраняется в регистре, который используется в команде.

В бит ориентированных командах 'b' определяет номер бита участвующего в операции, а 'f' - указатель регистра, который содержит этот бит.

В командах управления или операциях с константами 'k' представляет восемь или одиннадцать бит константы или значения литералов (постоянными константами, определенными на этапе программирования).

[image: image4.wmf]Табл. 1. Описание полей команд.


Все команды выполняются за один машинный цикл, кроме команд условия, в которых получен истинный результат и инструкций изменяющих значение счетчика команд PC. В случае выполнения команды за два машинных цикла, во втором цикле выполняется инструкция NOP. Один машинный цикл состоит из четырех тактов генератора. Для тактового генератора с частотой 4 МГц все команды выполняются за 1мкс, если условие истинно или изменяется счетчик команд PC, команда выполняется за 2мкс. Мнемоника команд, поддерживаемая ассемблером MPASM, показана в таблице 2. 
[image: image5.wmf]Табл. 2. Список команд микроконтроллеров 

PIC16F874.


4. Команды присвоения и пересылки. Работа с регистрами.

Команды присвоения и пересылки в контроллерах PIC16F874 представлены тремя командами: movf (move register ‘f’), movlw (move literal to ‘work register’) и movwf (move ‘work register’ to register ‘f’). Также могут использоваться команды очистки clrf (clear register ‘f’) и clrw (clear ‘work register’). 

Рассмотрим формат каждой из команд подробнее.
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Пример использования этих команд:

;
File name:
   moving.asm


list p=16f874


; определяем тип контроллера

#include <p16f874.inc>
; подключаем файл определения символических имен





; для данного процессора

a1
equ
0x20

; объявляем переменную a1 по адресу 0x20 – с этого адреса в 

; PIC16F874 начинается свободная область памяти данных

; (регистры общего назначения) 

a2
equ
0x21

; объявляем переменную a2 по адресу 0x21
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_A
equ
0x0A

; определяем константу A равную 0x0A
_B
equ
0x20

; определяем константу B равную 0x20

_C
equ
.10

; определяем константу C равную 10 (десятичное) 


org
0x00

; установить адрес начала программы - 0x00 - адрес вектора 






; сброса


goto
start

; переход на начало основной программы

org
0x04

; начало размещения следующей части программы в памяти –






; здесь должен располагаться вектор прерываний

start




; метка начала основной программы 


bcf
STATUS, RP0
; включили банк 0

movlw
_A

; запись в рабочий регистр константы A ( A = 0x0A ) w = 0x0A

movwf
a1

; копирование значения из рабочего регистра в переменную a1






; теперь  a1 = 0x0A

movwf
a2

; копирование значения из рабочего регистра в переменную a2






; теперь a2 = 0x0A

movlw
C

; запись в рабочий регистр константы C ( C = 10 ) w = 10

movwf
a1

; копирование значения из рабочего регистра в переменную a1






; теперь a1 = 10


movf
a2, 0

; копирование значения из переменной a2 в рабочий регистр






; теперь w = 0x0A

movf
a1, w

; копирование значения из переменной a1 в рабочий регистр






; теперь w = 10


movwf
a2

; копирование значения из рабочего регистра в переменную a2






; теперь a2 = 10


movlw
.10

; запись в рабочий регистр числа 10 (десятичное)


movwf
a1

; копирование значения из рабочего регистра в переменную a1






; теперь a1 = 10


clrf
a1

; очистить содержимое a1 ( a1 = 0 ) 


clrf
a2

; очистить содержимое a2 ( a2 = 0 ) 


clrw


; очистить содержимое рабочего регистра ( w = 0 ) 


end


; директива компилятору - конец программы
Задание. 


Написать программу выполняющую действия по инициализации переменных, констант и пересылки значений из одного регистра в другой согласно варианта. Набрать программу в отладчике MPLAB, скомпилировать без ошибок и, вызвав окна просмотра переменных, убедится в правильности работы. Текст программы включить в отчет.

Табл. 3. Варианты заданий.

	№
	Переменные
	Константы
	Действия

	1
	a1, a2, b1, b2
	A=0x2f, B=100
	A>a1, B>b1, a1>a2, b1>b2

	2
	a1, b1, c1
	A=24, B=0x0A, C=10
	A>a, B>b, C>c, 0>a, 0>b, 0>c

	3
	a1, a2, a3, a4, a5
	A=0x10
	10>a1, a1>a2, a2>a3, a3>a4, A>a5

	4
	a1, b1 
	A=10, B=20, C=30
	0>a1, 0>b1, A>a1, B>b1, C>w

	5
	a1, a2, a3, a4
	A=0xFF, B=0x20 
	A>a1, B>b1, 0>a3, 0>a4, a3>a1, a4>a2

	6
	a1, b1, c1, d1
	A=200, B=201
	A>a1, A>b1, B>c1, 0>d1

	7
	a1, a2
	A=0x01, B=0x02, C=3, D=4
	0>a1, D>a2, A>w, w>a2, C>a1, a1>w, B>a1

	8
	a1, b1 
	A=100, B=50, C=0x1A
	A>a1, a1>b1, B>w, w>a1, C>b1

	9
	a1, a2, a3, a4 
	A=0x01, B=0x02
	B>a4, A>a2, a2>a1, a4>a3, 0>a4, 0>a2

	10
	a1, b1, c1, d1
	A=10
	A>a1, a1>b1, 100>c1, 0>d1

	11
	a1, a2 
	A=0x20, B=0x21, C=10
	0>a1, 0>a2, A>w, w>a1, B>a2, C>w

	12
	a1, b1
	A=0x10, B=0x11, C=0x12
	10>a1, a1>b1, 0>a1

	13
	a1, b1, c1
	A=0x0A, B=10, C=20
	A>a1, B>b1, C>c1, a1>w

	14
	a1, a2, a3, a4
	A=100, B=255
	25>w, 40>a1, a1>a4, 0>a2, 0>a3

	15
	a1, b1
	A=0x20, B=0x21
	0x20>a1, a1>b1, B>b1, b1>a1

	16
	a1, a2
	A=45, B=0x45, C=100
	45>a1, 0x45>a2, C>w, a2>a1

	17
	a1, b1, c1, d1
	A=0x01, B=1
	A>a1, B>b1, a1>c1, b1>d1, 21>a1

	18
	a1, a2, a3
	A=40, B=100, C=255
	0>a1, 0>a2, 0>a3, A>w, w>a1, a1>a2

	19
	a1, b1
	A=0x10, B=0x02
	10>w, w>a1, w>b1, B>a1 

	20
	a1, a2
	A=0x20, B=0x21, C=0
	A>a1, B>a2, 0>w, 0>a1, 0>a2

	21
	a1, b1, c1, d1
	A=10, B=20, C=30, D=40
	A>a1, 20>b1, 0x30>c1, 0x40>w

	22
	a1, a2, a3, a4
	A=0x10, B=0xAA
	0xAA>a1, B>a2, a1>a3, a3>w

	23
	a1, b1
	A=0x20, B=0x21
	0>w, w>a1, a1>b1, A>a1, B>b1

	24
	a1, a2
	A=10, B=20
	0x10>w, w>a1, w>a2, B>a1, 0>a2

	25
	a1, b1, c1, d1
	A=0x0A, B=0x0B, C=0x0C
	A>a1, B>b1, 0xCC>c1, 0>d1  

	26
	a1, a2, a3, a4
	A=0x20, B=0x21
	0>w, 0>a1, A>a1, a1>a2, a2>a3, 10>a4

	27
	a1, b1
	A=100, B=0x10
	10>a1, 0>b1, a1>b1

	28
	a1, a2
	A=0x20, B=20
	A>a1, 0x20>a2, 0>w, a2>a1

	29
	a1, b1, c1, d1
	A=15, B=0x15, C=100
	0>a1, B>b1, b1>a1, b1>c1, 0>w


Лабораторная работа №3.

Исследование организации программного управления в микронтроллерах.

Цели работы: 

1. Изучить команды условных и безусловных переходов микроконтроллера PIC16F874.

2. Ознакомиться с примером построения циклов. 

3. Изучить способы организации и команды вызова подпрограмм. 

4. Составить программу согласно варианта задания.

Выполнение работы:

1.  В наборе команд любого процессора обязательно присутствуют команды, выполнение которых приводит к изменению порядка выполнения основной программы. Такие команды делятся на два основных типа: команды условного перехода и команды безусловного перехода. Кроме того существуют команды управления, с помощью которых осуществляется организация вызова подпрограмм или процедур, предназначенных для многократного использования. 


Команды условного перехода или перехода по условию работают следующим образом. При выполнении команды проверяется некое условие, при выполнении которого происходит переход в другое место программы. Переход осуществляется принудительным изменением счетчика команд процессора. В счетчик команд записывается адрес ячейки памяти, в которой содержится команда, которая будет выполнена следующей. Адрес перехода содержится в коде команды перехода и рассчитывается компилятором на этапе компиляции. Обычно этот адрес является не абсолютным, а выражается в виде смещения относительно адреса текущей команды.


В микроконтроллерах PIC16F874 команды перехода по условию представлены несколькими командами : 
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Команда безусловного перехода
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Пример:

a1
equ
0x20

; объявляем переменную a1 по адресу 0x20

a2
equ
0x21

; объявляем переменную a2 по адресу 0x21

…

btfsc
PORTA, 2
; конструкция полувыбора: пропускаем следующую 

; команду goto, если в регистре PORTA бит 2 равен нулю, и 

; заносим в регистр a1 число 10


goto
next

; безусловный переход на метку next

movlw

.10
; загрузить в регистр w число 10


movwf

a1 
; загрузить из w в регистр a1 число 10

next

…


btfss
PORTA,0
; конструкция выбора: если бит 0 порта A равен 1, то в 





; переменную a2 загружаем число 5, если же бит 0 порта A




; равен 0, то в a2 загружаем число 20.


goto
next2


movlw

.5


movwf

a2


goto
next3

next2


movlw

.20


movwf

a2

next3


…

2. Построение циклов.


В наборе команд микроконтроллера PIC16F874 отсутствует специальная команда для организации цикла, поэтому обычно цикл строят с использованием конструкции 
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Рассмотрим пример цикла, который выполняется 10 раз:
counter 
equ
0x20
; объявляем счетчик


… 


movlw
0x0A

; запись в рабочий регистр начального значения 0x0A (10)


movwf
counter
; инициализирование счетчика значением 10

loop




; метка начала цикла


…







; тело цикла


…


decfsz
counter,f
; уменьшить счетчик, если результат 0 – пропустить






; следующую команду


goto
loop

; повтор цикла


…

3. Подпрограммы используются для упрощения написания сложных программ. 



Подпрограммой называется специальным образом организованный фрагмент программного кода, который во время выполнения программы может выполняться несколько раз. Характерной особенностью использования подпрограмм является значительное уменьшение размера программ, благодаря многократному использованию одного и того же фрагмента кода.

Для языка ассемблера микроконтроллера PIC16F874 подпрограмма никаким особым образом не выделяется и начинается обычной меткой. Конец подпрограммы заканчивается одной из команд: return, retfie или retlw.
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Для вызова подпрограмм используется команда call.
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Структуру и вызов подпрограмм рассмотрим на примере организации подпрограммы задержки. Цель работы подпрограммы - временная задержка выполнения основной программы. Это достигается за счет циклического многократного выполнения некоторой простой комбинации команд.

CountDelay

EQU
0X20

; переменная-счетчик для организации задержки

DELAY_TIME
EQU
.100

; значение, которым инициализируется счетчик –







; время задержки около 80 мкс 

; основная программа

…








call
delay



; вызов подпрограммы задержки

…


call
delay



; еще один вызов подпрограммы задержки

…

delay





; начало подпрограммы задержки


bcf

STATUS, RP0
; выбираем нулевой банк памяти


movlw

DELAY_TIME
; загружаем время задержки в рабочий регистр 


movwf 
CountDelay

; загрузка счетчика из рабочего регистра 

del_loop




; цикл задержки 


nop




; команда ‘нет операции’


decfsz

CountDelay, 1
; уменьшаем счетчик на 1, результат помещается

; снова в регистр CountDelay. Если CountDelay
; равен 0, то следующая команда пропускается  


goto

del_loop 

; переход на начало цикла задержки


return




; возврат из подпрограммы


Время задержки определяется временем выполнения команд внутри цикла задержки. Команды ‘nop’ и  ‘decfsz  CountDelay, 1' выполняются за один машинный цикл. Команда ‘goto  del_loop' изменяет счетчик команд, поэтому выполняется за два машинных цикла. Один машинный цикл состоит из четырех тактов генератора. 

Например, при частоте тактового генератора 20 МГц, один такт будет равен  0.05 мкс, а один машинный цикл равен 0.2 мкс:

1 маш.цикл = 1 такт * 4 = 0.05*4 = 0.2 мкс. 

Для рассматриваемого цикла задержки:

Задержка = CountDelay*(0.2+0.2+0.4) = 100*0.8 = 80 мкс

Вообще все команды микроконтроллера PIC16F874 выполняются за один машинный цикл, кроме команд условия, в которых получен истинный результат и инструкций изменяющих значение счетчика команд PC. В случае выполнения команды за два машинных цикла, во втором цикле выполняется инструкция NOP.

Варианты заданий.

Заданием для выполнения лабораторной работы является написание студентом программы согласно варианта с последующим пошаговым контролем правильного выполнения программы с одновременным наблюдением за значениями всех переменных программы. 

Текст программы включить в отчет о выполнении лабораторной работы вместе с вариантом задания.

Варианты 1-10.


Составить программу, реализующую функцию широтно-импульсного генератора. На одном из выводов портов контроллера генерируется сигнал прямоугольной формы, имеющий заданные значения длительности импульсов и паузы между между ними. С помощью изменения ширины импульсов выполняют регулировку скорости вращения современных двигателей, мощность нагревателей, яркость свечения светоизлучающих элементов и др. 

	№ варианта
	Вывод
	Длительность импульсов, мкс
	Длительность пауз, мкс

	1
	PORTB.1
	10
	20

	2
	PORTB.2
	100
	10

	3
	PORTB.3
	30
	50

	4
	PORTB.4
	40
	100

	5
	PORTB.5
	50
	60

	6
	PORTB.6
	60
	40

	7
	PORTB.7
	70
	20

	8
	PORTB.0
	80
	200

	9
	PORTB.1
	90
	140

	10
	PORTB.2
	100
	120


Варианты 11-20.


Составить программу генерации одиночного прямоугольного импульса. Импульс имеет заданную длительность и формируется после размыкания контактов, подключенных к одному из входов контроллера. Такими контактами могут быть контакты кнопочного выключателя, клавиатуры управления или датчика, работающего на размыкание, например, датчика перемещения в системе охраны, термодатчика и т.п. По условию при размыкании контактов на заданом входе порта кратковременно появляется логическая единица. После этого на заданном выходе появляется импульс положительной полярности определенной длительности.

	№ варианта
	Вход
	Выход
	Длительность импульса, мкс

	11
	PORTD.1
	PORTC.7
	200

	12
	PORTD.2
	PORTC.0
	100

	13
	PORTD.3
	PORTC.1
	50

	14
	PORTD.4
	PORTC.2
	10

	15
	PORTD.5
	PORTC.3
	60

	16
	PORTD.6
	PORTC.1
	30

	17
	PORTD.7
	PORTC.5
	20

	18
	PORTD.0
	PORTC.7
	120

	19
	PORTD.1
	PORTC.3
	140

	20
	PORTD.2
	PORTC.4
	80


Варианты 21-30.


Составить программу включения/выключения исполнительного механизма в результате нажатия на кнопочный выключатель или замыкания контактов клавиатуры. В качестве индикатора включения/выключения может служить светодиод, подключенный к заданному выводу микроконтроллера. По условию включение происходит при замыкании пары контактов, подключенных к одному из входов контроллера (кратковременное появление логического нуля), а выключение при замыкании пары контактов, подключенных к другому входу контроллера (кратковременное появление логического нуля). После включения на заданном выходе появляется логическая единица, после выключения – логический ноль. 

	№ варианта
	Вход «включение»
	Вход «выключение»
	Выход

	21
	PORTD.1
	PORTD.2
	PORTC.0

	22
	PORTD.2
	PORTD.3
	PORTC.7

	23
	PORTD.3
	PORTD.4
	PORTC.1

	24
	PORTD.4
	PORTD.2
	PORTC.5

	25
	PORTD.5
	PORTD.3
	PORTC.2

	26
	PORTD.6
	PORTD.1
	PORTC.7

	27
	PORTD.7
	PORTD.5
	PORTC.2

	28
	PORTD.0
	PORTD.7
	PORTC.7

	29
	PORTD.1
	PORTD.3
	PORTC.6

	30
	PORTD.2
	PORTD.4
	PORTC.2



При использовании портов, необходимо выполнять начальную инициализацию портов, а также не забывать контролировать активный банк памяти данных. 


Порты контроллера PIC16F874 являются двунаправленными. Регистры TRISA, TRISB, TRISC, TRISD, TRISE отвечают за направление работы выводов портов. Запись нулей в биты этих регистров переводит соответствующие выводы портов в состояние «выход». Запись единиц, соответственно, в состояние «вход». Часть выводов одного порта может работать на вход, а часть на выход. Поэтому допускается побитная установка/сброс управляющих регистров TRIS*. Полный сброс всех бит регистров в ноль осуществляется командой clrf f. Побитная установка/сброс выполняется при помощи команд bsf f,b (установка) и bcf f,b  (сброс).
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Регистры TRISA, TRISB, TRISC, TRISD, TRISE находятся в банке 1 памяти данных. Переключение банков памяти данных обычно осуществляют с помощью команд bcf STATUS, RP0 (установить текущим банк 0) и bsf STATUS, RP0 (установить текущим банк 1).

Пример.

init
bcf
STATUS, RP0
; установить текущим банк 0

clrf
PORTA

; обнуляем выводы портов

clrf
PORTB
clrf
PORTC
clrf
PORTD
clrf
PORTE

bsf
STATUS, RP0
; установить текущим банк 1

clrf
TRISA

; установка всех выводов порта A как «выход»

clrf
TRISB

; установка всех выводов порта B как «выход»

clrf
TRISC

; установка всех выводов порта C как «выход»

clrf
TRISD

; установка всех выводов порта D как «выход»

clrf
TRISE

; установка всех выводов порта E как «выход»

bsf
TRISD, 0

; установка вывода 0 порта D как «вход»

bcf
STATUS, RP0 
; установить текущим банк 0

…

Лабораторная работа №4.

Арифметические команды.

Цели работы: 

1. Изучить арифметические команды микроконтроллера PIC16F874.

2. Составить программу выполняющую арифметические действия

    согласно варианта задания.

Выполнение работы:

В микроконтроллерах семейства Microchip присутствует набор арифметических команд, при помощи которых можно реализовать любую математическую функцию. Вообще, в микроконтроллерах, а также микропроцессорах любая сложная математическая функция, например, нахождение интеграла или квадратного корня, расскладывается на ряд простых математических операций, таких как умножение, деление, или, даже, только сложение и вычитание. Затем нахождение функции выполняется в виде процедуры, которая вызывается как единое целое. 

В этом смысле контроллер PIC16F874 не составляет исключения. В нём присутствуют следующие арифметические команды. 
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Пример. 


Найти результат сложения двух байт.

byte1

equ
0x20
; объявляем переменные

byte2

equ
0x21
;

sum

equ
0x22
; 

value1

equ
.10
; значения переменных для примера

value2

equ
.20
;

…

movlw   value1
; инициализируем переменные

movwf
  byte1

;

movlw
  value2
;

movwf
  byte2

;

…

movf
   byte1, 0
; складываем byte1 и byte2

addwf
   byte2, 0
;

movwf
   sum

; результат сохраняем в переменной sum

…

В случае, если необходимо сложить два числа большего размера чем один байт, необходимо использовать флаг переполнения. Флаг переполнения или переноса (carry flag) содержится в 0 бите регистра STATUS и  устанавливается в 1 в случае, если в результате предыдущей арифметической операции произошло переполнение (или заем) старшего бита.

Пример. 

Сложить два слова.

byte1_0
equ
0x20
; объявляем первое слово (два байта)  

byte1_1
equ
0x21
;
byte2_0
equ
0x22
; объявляем второе слово (два байта)
byte2_1
equ
0x23
;

sum_0

equ
0x24
; слово суммы (два байта)

sum_1

equ
0x25
;

value1_0
equ
0xFF
; значения переменных для  примера
value1_1
equ
0x1A
;

value2_0
equ
0x01
; 
value2_1
equ
0x0B
;

…

movlw
  value1_0
; инициализируем переменные
movwf
  byte1_0
;

movlw
  value1_1
;

movwf
  byte1_1
;
movlw   value2_0
;
movwf
  byte2_0
;

movlw
  value2_1
;

movwf
  byte2_1
;

…

movf
   byte1_0, 0
; складываем младшие байты слов
addwf
   byte2_0, 0
;

movwf
   sum_0
; результат сохраняем в младшем байте 





; переменной sum
movf
   byte1_1, 0
; копируем в рабочий регистр старший байт 




; первого слова
btfsc
   STATUS, 0
; тестируем флаг переноса, если он равен 1 (после 





; последнего сложения), то добавляем еще 1
addlw     1


addwf
   byte2_1, 0 
; прибавляем к рабочему регистру старший байт




; второго слова
movwf    sum_1
; сохраняем старший байт результата

…

Варианты заданий.

Варианты 1-15. 


Найти сумму двух двойных слов.

Варианты 15-30. 


Найти сумму массива, состоящего из четырех байт.

В отчет включить текст программ и листинг компиляции.

